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Introduction

The aP23KWC28S USB Writer is designed to suppott&pP89K series Voice chips. It is suitable for:

- aP89682K (682 sec, 11 I/O chip) — SOP28
- aP89341K( 341 sec, 11 I/O chip) — SOP28
- aP89170K( 170 sec, 11 I/O chip) — SOP28
- aP89085K( 085 sec, 11 I/O chip) — SOP28

This development system serves three main functions

Compiler —to create a dp2 file from user’s Voice files
Writer — to program the dp2 file into the aP23xxx chip
Copier —connect DC 5V adaptor for 1 to 1 programming

The Compiler is used to combine the edited voice files intodhip to form the desired Voice Group and
to define the playback functions of each Voice Grby selecting different Options and Trigger Modes
of each individual Voice Group.

TheWriter is used to program the voice data into the aP28ex#ces that resulted from the Compiler
Function. A Writer Board connected to the PC viB port is required.

TheCopier is using the compiled *.dp2 which loads to writeen disconnect the USB and connect the
DC 5V for 1 pcs copying.
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Installation

Hardware Installation

aP23KWC28S is a USB based writer programmer. ifttended to be used in Windows XWin7,Win8,
Win10 computer.

Writer Board Connection

1) Connect USB cable from the writer board to the cotep The computer will display a new
hardware is found message. The installation veitJib automatically.

2) If there are too many USB devices are connectgouo computer at the same time, the current
supply from USB may not be sufficient to suppo#d writer board.
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Fig. 1 The aP23KWC28S USB Writer Programmer Board
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Running The Software
Double click the file23KWComplier.exeto launch the software.

= COMPILER:

e 23K Compiler-v2.3 >
Check Sum: 15. |_|

]

Compiler  Writer About 3.
D OAC Debounce Voltage Qutput Option:
‘ aP89341K 1_I % ” Key Mode 2_| it ‘ Config PYWM (®) 16ms (O 55us ®3av Cutl :Busy-H
(4.5v
Wave File | High Volume - | Qut2 :LED- Flash
4. Set Oscillator: []XT []B¢ [t
Grou edge Holdable Tri Sto Output
o
I L
Type : Compression |——_’—|
OuLaws 3 @ PCM15 Add-Wav
(CIPCME (7) ADPCM4 7. isnence
File Name Size Rate Type Use %
_| VoiceFile Prog - Bus Table Use Table Start T
a.

10.]

B wf —nj

Usage : 528 < 1048576 (0% ) LoadDp2 Compiler

COMPILER DESCRIPTION:

1. Select your required IC body.
--- aP23682-8pin , aP23341-8pin , aP23170-8pir23685-8pin.
--- aP23682-16pin , aP23341-16pin , aP23170-16aR23085-16pin.
--- aP89682K , aP89341K , aP89170K , aP89085K.

2. Select your required trigger mode.
--- Key mode / CPU parallel mode / MP3 mode / SBd&/ 12C mode / aP89 mode / SBT mode.

3. Select voice output mode.
--- DAC or PWM.

4. Show all your required voice files. (Only wale$ acceptable).
--- The [xxx.wav]: 8 bits or 16 bits mono xxx.wav.

Page 4 of 33 5/6/2016



JFLUS Inteqrated Circuits Inc. aP23KWC28S USB Writer User Guide

5. Select the compression mode.
--- ADPCM4 / ULAWS8 / PCM8 / PCM16.

6. Select your required voice file [xxx.wav] folder

7. Select if adding the silence.
--- 1ms ~ 10000ms.

8. Loading the required *.wav files.

9. Setting your required voice sections and fumctrede.

10. Show your final voice list.

11. Compiler: After setting the voices & functigrysh the button to create xxx.txt & xxx.dp2 files.
12. Re-download & Re-editing [xxx.dp2] to settimydafunction.

13. Show the memory of your usage.

14. Show the IC body memory size.

15. Show Check Sum.
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e 230 Compiler-V2.3 >
Compiler  yriter About |Ch'9Ck Sum : |
D DAC Debnunoe I Voltage Output Option: g,
|aP89341K | Key Mode ol Do | @1éms Otss | @ 21.foutt -
(a.5v
Wave Fie [high Votame 20- |1 Out2 :LED. Fash
p 17
sewo: Elon Don =) ous s
Set Oscillator: [XT Bt [] .Int__'
Grow| edge Holdahle Tri Sto Output
Type : Compression
CIuLAWS ® PCM16 Add-Wav
pcma () ADPCM4 Silence
File Name Size Rate Type |Jse %
VoiceFile Prog - Bus Table Use Table Start T
Usage : 528 < 1048576 (0%) | loadDp2 | Compiler |
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s 23KWCompiler-V2.5 - X
Compiler | writer | About |Check sum : |
(aP23341 - 8pin | [ETTINN ~ | config E1SBT Key3 23 e || EoE

T — (1 PowerOnPlay al 4.5v
SBT Loop| 25. |
Set Volume M Int
Tri Sto Output
Type : Compression e

#w 23K Compiler-V2.5 e *

Compiler | writer | About |Check Sum : |
apeo341k | [EENITNN - |confi & s
Wavwe File PowerOnPlay = Out2 :LED- Flash

Out3 :Stop-H Stop-H -
[ 5et Volume Int
@SBT:PIPQ Tri Sto Output
OSBT:P/S

e 23KWCampiler-V2.5 - x

Compiler  writer  About |Check Sum : |
aPg9341K | SPI Mode + | config il | Rt
Wave File PowerOnPiay NV out2 sLED- Flash
Out3 :Stop-H
L1 Set Volume Int
Tri Sto Output
1 CPU Serial Option i'
16. Select required debounce time.

--- 65uUs or 16ms.
17. Select if using low voltage detect.
--- Select ON if the IC voltage less than\@W be reset.
18. Select if using the oscillator.
--- XT (X'tal=16MHz ) / Rosc ext ( 68K ohm/ Rosc Int.
19. Select the output function for outputl, outpatiput3.
--- Busy-H, Busy-L.
--- LED Flash (LED high active ) , ~LED FladED low active ).
--- Stop-H, Stop-L.
--- Prog-BusyH, Prog-BusyL.
--- Load: For the play command [094h+D9~00J9~D0] total 10 bits indicate the voice address.
Same the aP89341 preféitth [no gap loop play].
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20. Select PWM voice output volume.
---Select PWM high volume.

aP23KWC28S USB Writer User Guide

21. Select IC operating voltage at PWM (VOUT).
--- Low Voltage: 3V, High Voltage: 4.5V.

22. IC body configures advanced function.

23. Select SBT pin swap. (for 8pin device only).
--- Select (SBT as OUT1) or (SBT as KEY3).

--- SBT as OUTL1: Busy-H/L, Stop-H/L, LED Hed_ED high active),
~LED Flash (LED low active), Prog-BusyH/L, Load.

S3 (pin7) S2 (pin6) Group SBT = 0OUT1
0 1 SW1 Busy-H/L
1 0 SW2 Stop-H/L
1 1 SW3 LED ......

--- SBT as Keya3:

SBT ( pin5) S3 (pin7) S2 (pin6) Group
0 0 1 SW1i
0 1 0 SW2
0 1 1 SW3
1 0 0 Sw4
1 0 1 SW5
1 1 0 SW6
1 1 1 SW7

24. Select power on play.
--- Power on play [sw0] group once.

25. Select SBT loop. (At SBT mode).
--- Enable: The SBT pin sequential triggelo&p play.
--- Disable: The SBT pin sequential triggeplay once.
*Note: Voice function (Trig Level) must select Ledv

26. Select volume control function.
--- Select the volume control Level x16 //x81.

27. SBT pin act play/pause or play/stop functionM®3 mode.

28. Select if using pin S4 as data output pin.
--- The SPI mode or 12C mode of data output fopR4IC body and 16 pin IC body.
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= WRITER:
#us 23K Compiler-V2.5 . ®
Compiler Writer  About Check Sumn :
Grou| edge Holdable Tri Stol Output
2
4]
VoiceFile Prog - Bus Table Use Table Start T

5

0| 1] 5| ° | :
Blank Check Program Verify [ Security —l E:PZBESZ -8Pin  ~

Run | 12.
1', 0% L# Flash 'ULnad

WRITER DESCRIPTION:

1. Loading your programming file. (xxx.dp2)

2. Show setting and function after loading *.dg&.fi

3. Show your required IC body.

4. Show voice sections and function mode.

5. Show the content of your selected section afevtist.
6. Select to blank check IC is blank?

7. Select to execute programming.

8. Select to verify the data of your programming.
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9. Select if you need security mechanism.

*** (If do this, it can’t be copied; it can’t be Mzer IC.)
10. Execute your selected (6.) (7.) (8.) (9.).

11. Show the progress of “blank check”, “prografwérify” and “load to flash”.
12. Load to Flash: download the program file (xp2)to [1 to 1 copier] writer.

=  About:

s 23KWCompiler-V2.5 . =

Compiler Wiriter About Check Sum :

1.
‘Ja P23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

2. :
—waw.aplusmc.com.tw

sales@aplusinc.com.tw

3.
-—' Writer Firmware Version Detect

4.
JFlrn'ﬂ.-trare Update

ABOUT DESCRIPTION:

1. Show software version.

2. Show website of Aplus Integrated Circuits Inc.
3. Detect writer firmware version.

4. Update writer firmware version.
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» Example for Compiler :

e 23KV Compiler-V2.5 —
Compiler  \Writer  Abeadt ) c Check Sum :
— d b_l D DAC Debounce Voltage Output Option:
aP23682 - 8Pin —| Key Mode | config Glpam @ 16ms Osss @0 d |
4.5V
Wave File | High Volume E_J O
boku, wav Set LVD: off [Jon
R Ermers Set Oscillator: [ |XT [ |Bxdt /]It
MUSIC 02.wav
Super16A. wav M Group edge Holdable Tri Stoy Qutput
Train 01.wav P
| HELTHE x|
f Please Select a Folder
Type : Compression j |
O uLaws @ PcMis Add-Wav
IPCMB () ADPCM4 Silence | v o Data (D) "
b4 A
File Name Size Rate Type Use %
wawv
| wave E
ABT Builder =
| it B
Auto'Writer-APP
Builder_Project
China_Customer
Chk_dll
CLUS wav w
d
BE Eia
Usage : 528 < 2007152 (0%) | Loadbpz | | Compiler

1. Select the IC body is [aP23682 - 8Pin].

2. Select [Key Mode] to be our trigger mode.
3. Select the voice output is [PWM].

4. IC operating voltage at 3V.

5. Select PWM high volume.

6. Click Add-Wav to pick your required folder.
7. After confirming the folder, click the button.

8. All wav files in the folder will be listed here.

Page 11 of 33 5/6/2016



JFLUS Inteqrated Circuits Inc. aP23KWC28S USB Writer User Guide

Page 12 of 33 5/6/2016



JFLUS Inteqrated Circuits Inc. aP23KWC28S USB Writer User Guide

e 23K Compiler-W2.5 x
Compiler yriter  About |Check Sum : |
_ ; D DAC Debounce Voltage QOutput Option:
aP23682 - 8Pin - | Key Mode | config oor | @t6ms Osus | @
(4.5
Wave File | High Volume v |
baku.wav Set LVD: [Z]Off [JOn
CHILD. wav h Set Oscillator: | |XT [ |Bxt /It
MUSIC 02 wav
Super 164, wav Group edge Holdahle Trig Stop Output
Train 01.wav
Type : Compression
OuLaws U (OPcMis Add-Wav
@ pCMs () aDPCM4 k [Silence
i ’ 1 Use %6
Silence Time (1 ~ 10000 mS) Ok
b 2
Ct ms Cancel 4 VoiceFile Prog - Busy Table Use Table Start Type
Ll 3
Super 164, wav 512296 16000 PCM3 12
Train 01.wav 46618 12000 PCMB 2
Silence @ 20mS 0 16000  Silence 0
i
i-1
Usage : 503624 << 2097152 (24 %) LoadDp2 Compiler

9. Show all your required *.wav files. Double cliakav files you required in h, they will be showed.i
9-1.1f you once required multiple wav files to beowsied in i. (Mouse left button as begin item after

mouse right button as end item and click Add-MWiav at the same time).
9-2.1t will show the memory size you has been used.

(Please note the data size you loaded can’t exbedobody’s memory).

*** Please note the data size you loaded can't eddbe body’'s memory. If so,

there are some ways to solve this problem:

1). Change it to a bigger memory size bodya®23085-8Pin to aP23341-8Pin.

2). Compressed the wav files to decreasenéraory size. ex: from PCM16 to PCM8.

3). Delete some required voice files.

10. If wav file is too big, we can choose compnegdiles to decrease their sizes.
(UALW8 compress wav file to 8bits, PCM8 congmeavav file to 8bits,
ADPCM compress wav file to 4bits).
*** Please note if your original voice is 16bits wéle which need to be compressed to 8 bits,
We suggest you choose ULAW would be better.
11. If you want to add mute voice, click Silencetbn to set the silence time.

12. If need silence 20ms. Key in 20 (unit ms) thikck OK button.
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e 23K Compiler-v2.5

Type : Compression

>
Compiler | writer About |Check sum :
_ : | | pac Debounce M l Vaoltage ﬁ Output Oplion:
aP23682 - 8Pin | Key Mode | config e | @tems Goms @
] ol Oawv

Wave File | High Volume

bol.wav SetLvD: Foff [Jonp ﬂ

. Set Oscillator: [ |XT [ TBxt [/Int

MUSIC 02.wav

Super164.wav Grou edge Holdable Tri Sto Qutput

Train 01.wav

COuLaws (IPCM1s [ Add-Wav ‘

® PCME () ADPCM4 I Silence ‘

File Name Size Rate Type Use %

boku. wawv 35650 12000 FCM3 2 |
CHILD.wav 91676 12000  PCMg 4 | VoiceFile Frog - Bus Table Use Table Start T [
MUSIC 02.wav 73004 12000 PCM3 3

Super 164, wav 512296 16000 FCM3 1z [
Train 01.wav 45618 12000 PCM3 2

Silence : 20mS 0 16000  Silence i

Type : Compression
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Usage : 503624 < 2097152 (249%) LoadDp2 | Compiler
i 23K Compiler-V2.5 . >
Compiler  wyriter About |Check Sum :
. | ] d kage Qutput Option:
aP23682 - 8Pin v|| Key Mode o ‘;Conﬁgl SBT Outl - £ i o
4.5V
T L] PowerOnPlay ﬂ
boku,wav SBT Loop U
CHILD.wav Set Volume ﬂ Int
MUSIC 02.wav
Super 164, wav i Sto Output |
Train 01 waw
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i 23K Compiler-V2.5 = x
Compiler  yyriter  About |Check Sum : |
[aPso170k  .|[SPI Mode | config rocal N B

Wave File PowerOnPlay V. outz iLED- Flash
boku.wav ﬂ Volume Warp ¢ [ |Disable []Enable lm
;:I;-[DCII;I:,\:\-BV Set Volume Vol Level : ol Default : IS—VI

Super16A.wav

1 Qutput
Train 01.wav w Set s

CPU Serial Option [ SPI - 4 wire : Pin 54 as DO

Close I2C - 3 wire : Pin 54 as DO

Type : Compression
O uLaws O)PCMIG Add-Wav PULL-TYPE

(® Internal PULL-UP

(® PCMa () ADPCMA4 Silence
(Mo internal PULL-UP
File MName Size Rate Type Use %
i Set w-1 |
boku,wav 35650 12000 PCM3 F

13. Select the signal timing. (16ms or 65us).

14. IC operating voltage at 3V.

15. Select PWM high volume.

16. Select set Low Voltage Detect when voltage tleas 2V IC will be reset.

17. Select set Oscillator from Crystal mode(X'téd#dHz), External Rosc mode(68K),
Internal Rosc mode. ( if selecting Crystald®olt must set at pin MO & pin M1).

18. SBT pin swap other I/O pin function.
ex : SBT pin swap to OUT1 as output use.

19. Disable the power on play function. It doesinonhediately play [SWO] once.

20. When trigger in “SBT mode”.
If enable the [SBT Loop]: It will one key sequehtidgger and keep loop play in every group.
If disable the [SBT Loop]: It will one key sequaltirigger and play one time in every group.
(*** Note: Trig Level must select Level).

21. Output Option: Setup the outl, out2, out3.
Can select the Busy-H, Busy-L, Stop-H, Stop-L
LED Flash (LED high active), ~LED Flash(LED lowtee),
Prog- BusyH, Prog-BusyL, Load.

22. [Set volume] control function.
---Select the volume control Level x16 / x8 / x4.
---The volume control key by the [M1] and [MO] key.
Volume Warp: Volume level increase to the max thegin from the level 1.
Select disable:
Pin MO: volume Level [+ 1].
ex: Level x8, 2>32>4->52>6>7>8>8->8-> ....
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Pin M1: volume Level [- 1].

ex: Level x8, ®72>6>52>4>32>2>12>1>1-> ...
Select enable:
Pin MO: volume Level [+ 1].

ex: Level X8, 2>32>4>5262>72>82>12>2>3> 4> ...
Pin M1: volume Level [- 1].

ex: Level x8, 72>6>524>3>2>1>8>7>6>5> ....

23. When set SPI Mode or 12C Mode, the pin S4iigléda output (DO) using.

#e 230N Compiler-V2.5

Compiler  yyriter About |ChECk Sum :
: s D DAC Debounce Voltage Qutput Option:
aP23682 - 8Pn - | Key Mode v|lconfia| CPAC @ ems Osse @ outt eyt
)4.5v
Wave File | High Volume w |
boku.way Set LVD: [ oOff []On
CHILD.way Set Oscillator: | | XT | |EBxt /Int
MUSIC 02.wav
Super 164.wav Holdable p
Train 01.wav Unholdable Retrigger Panel-A =
Edge  Unholdsble |Refrigger  |Enable
S 3 Trig Level Huold Trigger Stop

e — (OiLevel (® Unholdable () Mon-Retrigger () Disable
OuLaws CIPcM1s Add-Wav (®) Edge (") Holdable (®) Retrigger (®) Enable
(® PCMB ) ADPCM4 Silence y

SW?2 2| —I oK Cancel
File Name Size Rate Type se %
boku.wav 35650 12000 PCM2 2
CHILD. wav 91675 12000 PCM3 4 VoiceFile
MUSIC 02.wav 73004 12000 PCM3 3 oku., wav
Super 16A.wav 5122965 16000 PCM3 12 HILD.wav
Train 01.wav 466158 12000 PCM3 2

) Up Panel-B [
U Down
Insert
Delete
Usage : 503736 < 2097152 (24 %) LoadDp2 Compiler

24. Double click Panel-A for your setting the fuonatof each Group.

25. Key in group number.

26. SW means group. ex : Select the second gradipl@uble click the wav files you required in (i)

then Panel-B will show them.

The mouse moves to Panel-B then enter right keydar adjusting the order of the wav files or irtser

or delete them.
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i 23KWCompiler-Va.5 *
Compiler \riter About |ChECk Surn : |
G B D DAC Debounce Voltage Quiput Option:
| aP23682 - 8Pin - ” Key Mode v | Config) = _ v @ 18ms Ossus gw Outt :Busy-H
4,5Y
Wave File | High Volume s |
boku.way Set LVD: [ Off []On
i o Set Oscillator: | |XT [ |Ext /]It
MUSIC 02.wav
Super 164, wav Group ] edge | Holdable ] Trig J Stop | Output
e L= SWi Edge Unholdable Retrigger Enable
Sw2 |Edge |Unhaoldable  |Retrigger |Eaakls
SW3 Edge Unholdable Datrigger Add
z-1 Multi-Add
Type : Compression SW-Begin: |2 _I 0ok
OuLAwS OPcmis Add-Wav Delete .
SW-End: |3 Cancel Pla
® PCMa () ADPCM4 Silence i
Trig Level Stop
File Mame Size Rate Type Use %% OLevel ® Edge
Hold
boku.wav 35850 12000 PCM3 2
CHILD.wav 91676 12000 PCM8 4 VoiceFile @ Unheldable O Holdable e
MUSIC 02.way 73004 12000  PCM3 3 e Trigger _ _ PCMS
Super 164.wav 512206 16000 PCM3 12 CHILD.wav O Nan-Retrigger @ Retrigger PCMS
Train 01.wav 46618 12000 PCM3 2 MUSIC 02.way %3;_ . qisa PCM3
Isanie anle
B/ Al
Usage : 503736 < 2097152 (24 %) LoadDp2 Compiler
p

27. If the mouse move to Panel-A and enter riglyt kewill show there are additional function faildy

multi-add, delete, play and stop.
Add: add single group.
Multi-Add: add multi-groups at one time (z-1).
Delete: delete the group.
Play: play all voices of the group.
Stop: stop the voice playback.
28. Finish compiling, click compiler button.
29. Generate Check Sum number.

30. Loading finished compiled .dp2 file.
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e 230N Compiler-v2.5 *
Compiler  writer About |Check Sum : |
i} - I ] D DAC Debounce Voltage Qutput Option:
[P23682 -8Pn v[KeyMode |jconfi| Oll @i Oss  ©3  outt -t
(4.5v
Wave File | High Volume w |

Set LVD: [Z]off [JOn
Set Oscillator: | =T Ext Int

| Groui ’ edie I Holdable ITrii I Stoi ’ Duﬁt

File is not exist *
cl |
Type : Compression : ; DA Avwaveboku wav I
OuLaws @PcMis Add-Wav | | 1 I DaAwave\CHILD.wav -
(IpCma () ADPCM4 Silence || -
File Mame Size Rate Type |Jse % \‘ |
boku.wav 0 0 PCMa a F-
CHILD. wav 0 0 PCMa o VoiceFile Prog - Bus Table Use TableStart | T
MUSIC 02, wav 73004 12000 PCM3 3
Super 164, wav 512296 16000 PCM3 12
Train 01.wav 46613 12000  PCMB 2
Panel-C ' Play
Stop C-1
Remove
Remowve All
Modify Path
sage @ 376298 < 2097152 18 % LoadDp2 Compiler
k (18%) p

31. Reloading .dp2 file if the voice file (*.wa\g not exist.

32. The mouse moves to Panel-C then enter rightdeeyour modifying the path of the wav files.
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» How to write the program file [ xxx.dp2 ] to IC :

#ne 23N Campiler-W2.5 — e
Compiler  Writer  about Check Sum : C1B1
Group edge Holdable Trig Stop Output D:\A\demo'demol.dp2
Key Mode
SW2 Edge Unholdable Retrigger Enable Use: PWM , Low Voltage : 3V
SW3 Edge Unholdable Retrigger Enable VOUT [ WM ] - Level 6
Power On Play: Disable
| Use: Rosc Int
ﬂ LVD: Off
SBT as Outl H

OutPutl: Busy- H
Execute Blank Check...
Blank Ckeck Success
Execute Program...
Program Finish

VoiceFile Prog - Bus Table Use Table Start Type Execute Verify...
Verify Success

CHILD, wav 1 a a PCM3

MUSIC 02.wav 1 1] 0] PCM3

ai

Blank Check Program  MVerify [ Security U |aP23682 - 8Pin v|

Run ﬂ _ﬂ

Load to Flash Load

a. Click [Load] button to load the program file k&lp2] file.
After loading, it will show Check Sum b~ c~d message.

e. Select Blank Check to check if this IC is blank.
Select Program to execute programming.
Select Verify to execute verification.
Select Security to execute IC security mechanism.
***(To avoid the data to be copied and it can’tdenaster IC).

f. Click Run button to execute all your selectesis in e column.
(Il show (e.) progress & (b) message).
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g. Click [Load to Flash] button to download .dp2 fio Writer.

Page 20 of 33 5/6/2016



JFLU5 Integrated Circuits INnC.  aP23KWC28S USB Writer User Guide

When writer is able to be a 1 to 1 copier. ***Y must do g. step at first)
1. Disconnect USB.

2. Connect 5V adapter.

3. Push program key to execute programming.

4. When programming, yellow LED flash.

When programming finished, green LED light.
When programming failed , no LED light.
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= Example for About :

s 23K Compiler-v2.5 = x

Compiler  Writer About Check Sum : C1B1

aP23xxx Series Voice OTP Development System

\ersion 2.5

Aplus Integrated Circuits Inc.

J www.aplusinc.com.tw

sales@aplusinc.com.tw

J Writer Firmware Versiom : V114

J Firmware Update

a. Double click thevww.aplusinc.com.twvill connect website Aplus Integrate Circuits Inc.

b. Double click the Writer Firmware Version will®l writer firmware version.

c. Double click the Firmware Update will load firrave file.
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***Note:

Writer and Copier only support the (*.dp2) fifteom 23KWCompiler version V2.4 or up.

Q1: How to update the latest firmware version.
Q2: How to convert (*.dat) format to (*.dp2) format

Q3: How to convert V2.1 & V2.2 & V2.3 (*.dp2) to V2 or up (*.dp2) format.

Ansl.:
e Compiler-V2 5 — ™
Compiler Writer  About Check Sum :
Group edge Holdable Trig Stop Output C:\Users\RD\Desktop\test_file\w2_3-dac.dp2
Writer Disconnect
Writer Information x
VoiceFile ’ Proi - Busi / Tablea @ Writer disconnect
I [
Blank Check Program Verify [ Security ‘ aP23682 - 8Pin v|
Run
U Dfﬂ Load to Flash Load

a. Writer must be connected PC after load (*.dp2) file

b. If Writer doesn’t connect PC, it will show Writersdonnect message.

Page 23 of 33 5/6/2016



JFLU5 Integrated Circuits INC. __aP23kwc28S USB Writer User Guide

dnm 230N Compiler-v2 x
Compiler  Writer  About |Check sum : |
Grou edge Holdable Tri Stoj Output C:\Users\RD'\Desktop'test_file'v2_3-dac.dp2
i - 1
Firmware Update ®
WoiceFile Prog - Bus ] .
e Update the |latest version firmware
T T |
Blank Check Program Verify [ Security | aP23682 - 8Pin v|
Run

0 D.-‘(Cl Load to Flash Load

c. If Writer connects PC,it will show Update the ldtesrsion firmware message.

d. Please click OK button.
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e 23K Compiler-V2 e

Compiler Writer  About | |

Grou| edge Holdable Tri Sto Output Get Imqg file (AP243C{_USB_Writer_v114.imq)
Execute Update Firmware...

Update Firmware Finish

Please replug in Usb Writer

- Firmware Update =

. —  Update Firmware Finish ...!
VoiceFile Prog - Bus Table Use Please replug in Usk Writer

T T |

Blank Check Program Verify O Security |aP23682 - 8Pin v\

Run

0. Dfﬂ Load to Flash Load

e. After finishing firmware update, click OK button@neplug in Usb Writer.
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s 23K Compiler-V2.5 . *

Compiler  Writer About |Check Sum : 3036 |

aP23xxx Series Voice OTP Development System

Version 2.5

Aplus Integrated Circuits Inc.

www.aplusinc.com.tw

sales@aplusinc.com.tw

Writer Firmware Versiom : V114

Firmware Update

f.

You can see About page to check Writer Firmwares\éer.
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Ans2:

dn 230N Compiler-V2.5 . Ead

Compiler  Writer  About Check Sum :

Groui ’ edie ’ Holdable ’Trii ’ Stoi ’ Ouﬁt
| |

X
e » T » EE » testfile w |0 EE test file o
EATHE v HHEENE ==~ [ @
* Downloads # * =t - R s A *
W == o 1% v1_2-dac.dat 2016/4/28 F51.. DATB= 1,024 KB
[ & #* 19 v1_2-pwm.dat 2016/4/28 b5 DAT 25 1,024 KB
= B8R » i v2_3-dac.dp2 2016/4/28 b5 1. DP2iE= 1,025 KB
— 150 v2_3-pwm.dp2 2016/4/28 b5 1. DP2 E= 1,025 KB
pic
test_file
TestGoGo
@ Onelrive
= B
* Downloads
5
h 52
W =a
EBRSEN): (vi_2-dacdat v| data files (*.dp2;*.dat) v
BE(O) HiE

a. At Writer page click Load button and select (*.d@B.
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e 230N Comp *
Compiler Writer  About |ChECk Sum |
Grou edge Holdable Tri Stoy Output C:\Users\RD\Desktop'test_file\wl_2-dac.dat
|
Fdat to *dp2 et
VoiceFile Prog - Bus | (%dat)file format will be changed to (*.dp2) format

Blank Check Program Verify [ Security \ aP23682 - 8Pin v|

Run

U Df‘ﬂ Load to Flash Load

b. It will show (*.dat) file format will be changed {¢.dp2) format message.

c. Click OK button.
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Compiler  Writer — About Check Sum :

Group edge Holdable Trig Stop Output C:\Users\RD'\Desktop\test_file\vl_2-dac.dat

e BEEE X

e » T » EE » testfile v @ EE test_file o

[
=t
3

>
ikr
filt
o
m
U

i
e
A

= EA # i v2_3-dac.dp? 20 . DP2
demo %0 v2_3-pwm.dp2 2016/4/28 5 1.. DP2#

il it
o
(=]
(%)
wn
=

test_file
TestGoGo

¢@ COneDrive
* Downloads
[ %
b ==

W=
= mE o

=ELA- A VBT _2-new-dad] v

ZFBEET): | data files (~dp2) v

~ EEERE s

d. Now save (*.dat) file as (*.dp2) file. The (*.dp2an be used as the data for program and verify. only
The (*.dp2) file don’t include sufficient informain for re-load to the compiler.
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Ans3:

e 23KV Compiler-W2.5

Compiler  Writer  About

= X

|Checl~: sum :

Grou| edge Haldable Tri Stol Qutput

| . The checksum will be modfied for new version compiler

VoiceFile ’ Pr| CheckSum Information x

C:\Users\RD'\Desktop\test_file'w2_3-pwm.dp2

' I
Blank Check Program [ Verify [ Security | aP23682 - 8Pin v|
Run
0 % Load to Flash

a. At Writer page click Load button.

b. Because the check sum rule has been modifiedadtsion V2.4,the check sum maybe different

from the original one.
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——

C:\Users\RD\Desktop\test_file\v2_3-pwm.dp2

Group edge Holdable Trig Stop Qutput

uk » T » EE » testfile ] E2 test_file 0

i
1
©

HEEHE ~ FEENE

B =% # A Ef

i
o
b

= Bk Bl v1_2-new-dac.dp2 2
demo 1o v2_3-dac.dp2
pic 8l v2_3-pwm.dp2 201

=)

test_file
TestGoGo

¢@ OneDrive
& Downloads
B
b =2

W SE
= A E

ERZEN) -

ZEEET): | data files (*.dp2) w

~ EEEEE B

L

c. Now save (*.dp2) file as version V2.5 (*.dp2) filehe (*.dp2) include sufficient information
for re-load to the compiler.
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Inserting Devices into the Programmer
- SOP package devices
- Device should be inserted align to the bottom ef2B-pin textool socket.

For

aP89085K-50P28
aP89170K-S50P28
aP89341K-S0OP28

ik

_—
=
-
-y
L
“Tn
»
=
>
o
“
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HISTORY

2015/03/27
aP23KWC28S User Guide.

2015/05/20
Dat file become dp?2 file.

2015/07/17
Add>Device map & Check Sum

2015/09/18
Add->Low voltage reset & CPU serial option.
Modify>Trigger mode & Silence time & Usage memory size Xe&te Run component control.

2016/02/01

Add-> Auto detect writer firmware version.

Add-> MP3 mode Play/Pause & Play/Stop option.
2016/02/24

Add-> Q&A.
2016/05/06

Add-> Select IC operating voltage.

Add-> PWM voice output volume.

Modify—> Change LVR to LVD.

Page 33 of 33 5/6/2016



